
The Time Is Now — The System Is 7

By Tom Pitts

You’ve been putting it off for a long time. Perhaps it’s due to fear of the unknown, 
or perhaps to a lack of memory — you’ve simply forgotten. Now is the time to 
make the System 7 plunge. Most software companies have upgraded their products
to take advantage of the many new features of System 7. If they haven’t yet 
released their final, System 7 savvy versions, most have distributed compatible 
versions and are feverishly working on the next upgrade so they can get a few 
more ‘upgrade bucks’ from their devoted customers. Let’s look at what you’ll 
encounter when you make the big switch.
Installation — one giant step for Mac-kind
Installation of System 7 is surprisingly easy. The disks in the upgrade kit (and there
are a lot of them) will do much of the job for you. A little advance planning is your 
biggest worry.
Your first concern should be whether your software is compatible with System 7. 
The upgrade disks contain Compatibility Checker, a HyperCard stack that you 
must copy to your hard disk before it can be used. Of course, you’ll need 
HyperCard ™ — version 1.2.2, if you are using a system before 6.0.5; and version 
2.1 for system 6.0.5 or later. Compatibility Checker, recently updated by Apple, 
simply compares the items in your System Folder and applications on your hard 
disk with a software database. It reports potential compatibility problems and 
offers to remove problem items from the System Folder and place them in a 
separate folder. It won’t hurt to let it move these things before you install the new 
system. In fact, it is a good idea to do so. Later, after the dust has settled, you can 
add the questionable items, one by one, back into the System Folder, to see if they 
do cause any problems. (Start with the ones you want most.) Remember that the 
compatibility checker is simply a database; it does not analyze the software on 
your hard disk. If you have an item with which Compatibility Checker is 
unfamiliar, or on which it has incorrect information, that item will be listed as a 
potentially incompatible program. When in doubt about the compatibility of your 
software, contact the manufacturer for exact information.
A few other preliminary steps will help insure a smooth transition. You need at 
least 2 Megabytes of RAM and a hard disk with 3 – 5 MB of free space. See your 
dealer for the latest driver software for your hard disk, or check out the listing of 
drive software in Lon Poole’s Quick Tips column (p. 211) in the March 1992 issue 
of MacWorld. Backup the hard disk, too. (Don’t believe the popular song Backing 
Up Is So Hard To Do.)
When you have prepared everything, take some time to think about your hard disk.
If it has been a long time since you last initialized and reformatted it, now is an 
excellent time to do so. The speed and overall performance of your hard disk will 



improve if there was a lot of fragmentation. When you restore your applications 
and other software to the clean hard disk, you can do so in a manner that will 
improve the disk’s performance, too. Read about hard disk management to get 
ideas on how best to rebuild the files on your hard disk. Finally, when you install 
the new system, if you did not erase your hard disk, you can remove the old 
System software, or you may simply install over the old system. (However, due in 
part to the much larger size of System 7, the latter may result in some 
fragmentation of system software on your hard disk.) I recommend initializing and 
reformatting your hard disk before you install System 7. It might be a little more 
work now, but afterwards you will have better hard disk organization and 
performance.

Nightmare on System Change Street
Many Macintosh owners have an innate fear of new system software — a fear well
justified by their experiences with system 6.0. Believe it or not, Apple actually 
listened to customer requests and criticisms, and developed an innovative, stable 
environment with System 7. 



Gone are the days of toying with Font/DA Mover and the worry of just when it 
would crash the system. Never again need you concern yourself with the decision 
of whether to brave the wilderness that was MultiFinder. Come fly with me over 
the new system landscape. We will first look at a few of System 7’s most unique 
and powerful features. It’s likely that you have read or heard something of them. I 
want to dispel some System 7 myths and fears right off the bat. Then we will delve 
into the more complex vagaries of the new system and seek the finer Finder. (Try 
to say ‘finer Finder’ very fast several times.)

A file by any other name…
Would you like to have many copies of certain applications, files, and folders 
where you can easily reach them on your hard disk without wasting valuable disk 
space or going through several levels of folders? You can with aliases. An alias is a
file, only 1 – 2K in size, that represents and is linked to its original file. You can 
create an alias of any item — a document, an application, a folder, even another 
disk. From the Finder, simply highlight the icon of the original and select ‘Make 
Alias’ from the Finder’s File menu. The new alias appears adjacent to the original. 
You may name it anything you wish and place it anywhere you need. Also, you 
may create as many aliases of an item as you wish, putting them in many places on
your hard disk. In the Finder, the name of an alias appears in Geneva italic, so you 
can easily recognize an alias file. When you open or double click an alias, the 
original is opened, no matter where it resides on your hard disk. If you cannot 
remember or find the original item of an alias, bring up the alias’ Get Info box. The
original is listed, and you can ask the system to find it with a click on a button. If 
the original is missing, you may have trashed it. If that is the case, you should toss 
out the alias, too.



Use the Get Info box to find the original of an alias.

Mobile Stationery Pads



Many of us use a particular document structure frequently — for example, a standard business memo or letter. Few applications 
offer a template format, also known as a stationery pad format. To use a document as a template, you can open it and use the Save
As… command to leave the original intact. Under System 7, you may define a document as a Stationery Pad — a template — 
that cannot accidentally be altered. (I did this with my most frequently used document formats, notably my business memo.) It is 
a simple process. First, create your desired document format using the application, such as a word processor. Save and close the 
document. Next, highlight it in the Finder and bring up its Get Info box. At the lower right corner, click in the Stationery Pad 
checkbox and then close the Get Info box. Your document icon changes to resemble a small notepad. When you double click, or 
otherwise open, the Stationery Pad, a dialog box appears. From this dialog box, you name and place the new document. Then it 
opens onto your desktop in the application that created it, ready for your work. You may make an alias of a Stationery Pad and 
place it anywhere on your hard disk for easy access. 

Create a Stationery Pad in the Get Info box.

Stationery Pad icons have a folded corner.



Friendly MultiFinder
One of the most publicized and most feared aspects of System 7 is multitasking. A surprising number of Mac users did not take 
advantage of MultiFinder under system 6.0.x. Perhaps this is the cause of the unfounded fear of System 7’s multitasking 
environment. Yes, it is true: with System 7 you always run in an environment like the old MultiFinder. There is no choice if you 
want to use System 7. There is, however, no reason to fear the new ‘MultiFinder.’ (Yea, tho’ I work in the vile shadow of 
MultiFinder, I will fear no crashes.) You can choose to run only one application at a time. The Finder will always be accessible in
the background. If you have not used MultiFinder before, that is the only difference to which you must adjust.
Veteran MultiFinder users will note few operational differences with the new system. (It is quite stable, probably because 
developers are accustomed to writing programs for the old MultiFinder.) You may run many applications simultaneously 
depending on your available memory (RAM). If you use the virtual memory feature, that can be a lot of memory. (Virtual 
memory is discussed below.) Under System 7, background program activities are allowed. This means you can continue to work 
in the front application while another process is ongoing in the background. Spreadsheet calculations, file compression, and disk 
copying are a few examples of background activity. Sometimes foreground applications slow a bit, depending on the type of 
background activity. You switch between open applications, including the Finder, by selecting from an Application menu in the 
upper right corner of the menu bar. As with the old MultiFinder you may also switch applications by clicking in a window of 
another open application. You can hide background windows — to avoid desktop clutter and increase speed — with a selection 
from the application menu or by holding down the option key as you switch applications. If you have any fear of instability, save 
your work often; that’s a good idea whether or not you are anxious about crashes.

Switch applications in the Application menu.

Thaw a frozen mouse
No matter what system you use, it will happen at some point. The mouse — everything — freezes. Under system 6.0.x you had to
hit the reset switch to end this cold war. If it occurs with System 7, you have a new option. Press the command, option and escape
(esc) keys simultaneously to force the foreground application to quit. You will lose any unsaved work, but you might release a 
frozen system/mouse. This is not always successful. If it is, however, you should save your work, quit from all other open 
applications, and restart the computer. I have avoided many a tap on the reset button with this method.



Force the foreground application to quit with command option escape keys.

Insufficient application memory is one potential cause of a system freeze. As with the old MultiFinder, you can alter the memory 
assigned to an application in the application’s Get Info box. Increase the application memory in the Current Size box within the 
Get Info box by approximately 10–15%, and restart the application. This process is virtually identical to that used under system 
6.0.x.
One of the most hated Mac dialog boxes is that which tells you the document you selected cannot be opened because the 
application is busy or missing. You used to get that box even if you tried to open an unopenable file such as an extension (INIT) 
or control panel device. It is little wonder so many novices (as well as veterans) were confused by this dialog box. System 7 goes 
a long way to correct this annoying problem. If you double click on a document that cannot be opened because the creating 
application is unavailable, the system attempts to open it with TeachText. You can open a few documents this way, but there are 
perhaps just as many that remain inaccessible. If you try to open an unopenable file, such as an INIT, a dialog box explains the 
problem. Most, but not all, such instances are correctly identified and explained. It is a pleasure when the computer explains a 
problem or mistake, rather than letting you wonder what you did wrong.

TeachText can open some documents.

Thanks for the memory
Is unlimited memory a myth? Yes… and no. Virtual memory is the use of hard disk space as additional RAM. System 7 allows 
virtual memory, if your Mac has a 68020 CPU with a PMMU (an additional memory management chip) or a newer CPU, such as 
the 68030 and 68040. (Thus, the 512K and earlier versions, Plus, SE, Mac II, Classic, old portables, and the LC cannot use virtual
memory.) There is a limit to the amount of hard disk space you may use as RAM. In the 24-bit addressing mode, real and virtual 
RAM may total 14 Megs, less 1 MB per each NuBus slot used. Up to a gigabyte of RAM is possible if you use 32-



bit addressing. The si, ci, fx, and newer Macs have ROM chips that support 32-bit addressing. With some older Macs, such as the 
II, IIx, IIcx, and SE/30, you can use the cdev, MODE 32 (free from Apple!), to enable 32-bit addressing. Not all software is 
compatible with this cdev, so some experimentation — and crashes — might be necessary if you go this route.

MODE 32 enables 32-bit addressing.

To use virtual memory, access the Memory Control Panel, turn virtual memory on, and select the amount of RAM you need. Set 
the RAM cache size, allowing at least 32K for each one MB of actual RAM that is installed. The new configuration will be used 
after you restart the Mac. Virtual RAM is slower than installed RAM, so do not be surprised if there is slightly less speed after 
you begin to use virtual memory. Nevertheless, the ability to run several memory-hungry applications at one time is a boost to 
productivity.



Set your memory parameters in the Memory cdev.

The System Folder lives
Among the nicer features of System 7 is the organization of the System Folder. It allows the use of subfolders to ease the clutter 
that all System Folders develop. The subfolders are: Apple Menu Items, System Extensions, Control Panels, and Start-up Items. 
Other Apple system software items that you will find in the System Folder include the System file (now a suitcase file), the 
Finder, the Scrapbook file and the Clipboard. If you use an Apple laser writer, Laser Prep and Backgrounder also appear in the 
System Folder. Many commercial and shareware applications place their own files and folders in the System Folder. Thus you 
may find such things as preferences files or folders, default settings files, help folders, and similar items. My System Folder 
currently has 52 items. Nevertheless, excellent organization is possible even with this many items due to the subfolder routine.
The Apple Menu Items folder contains anything that you want to appear under the Apple menu — this includes DAs, folders, 
applications, documents, aliases and Stationery Pads. Before System 7, only Desk Accessories and a few select commercial items
— for example Suitcase II™ — were permitted to reside there. Now you may configure the Apple menu items to suit your 
personal preferences. Place your most frequently used documents and applications (or, better, aliases of them) in the Apple Menu 
Items folder. They will be available for immediate access in the Apple menu — no need to navigate through various levels of 
folders. Naturally, you may still position desk accessories under the Apple menu by placing them in this folder. 
Special programs that are automatically run at the time you boot up your Mac have been called INITs. Under prior systems, all 
INITs sit in the System Folder; the system software recognizes and launches them at start-up. Under System 7, INITs are called 
system extensions, and they belong in the Extensions folder within the System Folder. Apple system software includes such 
extensions as printer drivers, AppleShare, File Sharing extension, Networking extension, Keyboard Menu, and Finder Help. 
There may be other items in your Extension folder, depending on your hardware.



The Control Panel is a desk accessory under previous versions of the operating system. System 7 does away with the Control 
Panel as a separate entity. Each control panel device (cdev) is now an independent program that may be accessed by double 
clicking on its icon (or by other standard opening methods). Rather than lying free in the System Folder, cdevs are placed in the 
Control Panels folder within the System Folder. Apple system software control panels are numerous and include the familiar 
ones such as Keyboard, General, Colors, and Mouse, as well as some that are new with System 7. Although individual Control 
Panels do not normally appear under the Apple menu, an alias of the Control Panels folder is placed there and you can put a cdev 
or an an alias of one in the Apple Menu Items folder. Thus, important cdevs can be accessed easily.
The Startup Items folder is also new. Place in it any files, documents, and/or application(s) — or aliases thereof — that you 
wish launched when you startup your Mac. For example, if you most often use a certain application with your computer, you 
might wish to place an alias of it in this folder so that it will be launched every time you start the machine. Most Mac users do not
have such a rigid pattern of work so that this folder often is ignored. I induce my Mac to play a favorite sound at startup by 
placing a snd file in this folder.

Pack away the suitcase
Under System 7 desk accessories have come out of their shell. Yes, you can still have DAs under the Apple menu, and System 7 
still calls them (as file type or kind) desk accessories. Apple system software DAs, such as Chooser, Calculator, and Puzzle, 
appear in the Apple Menu Items folder within the System Folder. A Control Panels alias is also placed there for you. However, 
you can store DAs anywhere you wish. More importantly, DAs now function as independent applications. There is no need for 
Font/DA mover. Most commercial and shareware DAs still come in a suitcase file. When you double click a suitcase file under 
System 7, it opens just like a folder. It contains the application that is the DA. You cannot run a DA while it is in the suitcase 
shell. To make it functional, simply drag that DA application from the suitcase to a standard folder — such as the Apple Menu 
folder. Close and discard the empty suitcase. You can run the DA by selecting it from the Apple menu, if you placed it in that 
folder, or by double clicking on its icon.

Take a Valium, please …
If you have an anxiety attack when you think of having to place an extension, DA, or cdev into the correct subfolder within the 
System Folder, you are in luck. System 7 will make the decision for you. There is no need for you to place the program into a 
subfolder manually. At the time you drag it to the System Folder icon, the system recognizes its type and decides where it 
belongs. A dialog box appears on screen to tell you where it will place the item and to allow you to cancel the placement if you 
desire. System 7 is almost always correct in its placement of such items into subfolders. Be aware that at the time of this writing, 
certain commercial extensions — Adobe Type Manager™, for example — do not function properly from within a subfolder. They
must be placed into an open System Folder. The documentation that accompanies the software should tell you if this is necessary, 
but if an extension does not function properly, try placing it into the open System Folder rather than in the Extensions folder.



System 7 makes System Folder management easy.

The System file clique
Before System 7, the System file was inaccessible except by software such as Font/DA Mover and ResEdit. There was little 
reason to access it except to add fonts and DAs. With System 7 the System file is a suitcase that can be opened by a double click 
on its icon. It contains fonts and sound resources. You may not alter the System file if any application is running. To add sounds 
(as an snd_ type only) and fonts (fonts are discussed below) to the System file you may drag them to the System Folder icon and 
let the system place them for you. You may also drag them into the System file directly. It is not necessary to open the System file
to add to it. You must open it, however, to remove items.
The sounds in the System file are accessible in the Sound cdev. You select a beep sound there. You will find recording options in 
the Sound cdev, if your Mac has that capability. You may play any snd_ sound resource by double clicking its icon in the Finder. 
Applications such as Suitcase II™ 2.0 and the popular SoundMover™ shareware package offer enhanced use of sounds under 
System 7.

Fonts — myth and magic persist
Apple and Adobe battled for a long time before finally settling the font war issue. TrueType was Apple’s entry into the war and is 
the type of font that currently ships with System 7. TrueType is a non-PostScript outline and screen font combination format. A 
TrueType font can be identified by its characteristic triple ‘A’ icon. In contrast, bitmapped fonts have a single ‘A’ with a plain 
background on their icon and usually contain the point size as part of their name, such as ‘Bookman 12.’ Double click on a 
bitmapped font to see a sample of that one size. If you double click on a TrueType font, the sample box displays the font in 9, 12, 
and 18 point sizes. There is no need to have both TrueType and bitmapped versions of the same font. Your printer will 
automatically use the TrueType version if more than one format is present. If you want to use a bitmapped font that you currently 
have stored in a suitcase file, remove it from the suitcase as described earlier for DAs, and place it in the System file. TrueType 
fonts produce better quality output on any printer than do bitmapped fonts. (Just don’t try to use them at a service bureau. —Asst.
Ed.)



TrueType font sample boxes show three sizes.

Bitmapped font sample boxes show only one size.

You may use PostScript fonts with System 7. (PostScript fonts have 2 parts, the screen, or bitmapped, font and the printer, or 
outline, font.) The screen font goes in the System file and the corresponding outline font goes in the Extension folder. If you have
any problem printing to a laser printer with this scheme, remove the printer fonts from the Extensions folder and place them free 
in the System Folder. Printer font icons vary. Some look like little laser printers, others appear as generic documents. The 
Adobe™ font icon is an 



outline, bold slanted ‘A’ on a field of horizontal stripes. If you have difficulty distinguishing among the various font formats, 
view them by Kind in the finder or check their Get Info boxes. If you prefer PostScript Type 1 fonts, it is easiest to use Adobe 
Type Manager™ and Suitcase II™ to avoid System Folder clutter and improve overall font management. Remove the TrueType 
versions of the Type 1 fonts of the same typeface. Leave Geneva, Chicago, and Monaco in the System file. The system software 
needs them even if you don’t. Contrary to popular misconception, New York is unnecessary, and so is the font.

Each font format has a different icon.

The ATM technology will be incorporated into a future upgrade of System 7. It is unclear if TrueType fonts will fit into the next 
system version. I recommend against building an extensive TrueType library. Similarly, there will be little need for bitmapped 
fonts that do not have a corresponding Type 1 printer font.

A newfound Finder
Soon after booting-up under System 7 you will note the new look of the Finder. The familiar apple is still there, as are the items, 
File, Edit, View and Special. A Label menu has been added between the View and Special menus. At the far right are three new 
icons denoting help, keyboard, and application. If you are used to MultiFinder, the application icon will not be new.

The Finder menu bar sports a new look.

Points of View
Among the more important aspects of the Mac’s desktop, and the one that most personalizes your interface, is the way you 
choose to view the hard disk and other windows. You still use the traditional Icon, Small Icon, and list (by name, size, kind, or 
date) view selections. New features have been added to the window views. You may select the display font and its size, and the 
appearance of icons in the list views. There are several options for the type of information the Finder will display, including the 
new item, ‘labels,’ and ‘comments’ (from a file’s Get Info box). The Finder can calculate and display the sizes of folders in any of
the list view modes. Although helpful, this feature slows down Finder actions a good deal if you have a lot of list view windows 
open. Under System 7, disk information may appear in list view window headers, a feature sorely lacking in previous system 
software.



Customize your interface with the View cdev.

A particularly good feature is the ability to look into folders in the list view without opening them. Simply click on a folder’s 
triangle-shaped pointer to display a hierarchical view of its contents.

See inside unopened folders with the List view mode.



Another helpful feature is the ability to show the hierarchical location of a window by holding down the command key while 
clicking the mouse in the title of the window. Highlight any folder in this hierarchical list and release the mouse to open it.

Move through folders from a window’s title bar.

Navigation through files and folders in the finder is aided by several new keyboard shortcuts. To select an item in the active 
window, type the first letters of its name. As you type, Finder soon highlights the desired file. You may also select icons by hitting
the tab key (selects alphabetically) or the arrow keys (to move in the direction of the arrow). To open the parent folder of a 
highlighted folder or file, hit the command and up arrow keys together. There are many other keyboard shortcuts that aid your 
productivity, especially if you do not like to use the mouse.
Manipulation of files and folders in the Finder is more flexible under System 7. You may move an item from an inactive to an 
active window by holding down the mouse button as you select and drag the item to its new folder. The option drag method still 
copies an item to the destination window, but under System 7 you need not depress the option button until you are ready to 
release the item to be copied. The marquee now selects multiple files in a window in both the icon view and in all list views, and 
scrolls automatically as you hold down the mouse to show files that are out of view. You can even select multiple files in an open 
window across various folder levels in the list view by the shift-click method.



Select multiple files and folders across levels in list views.

Under the apple tree
The ability to have any item under the Apple menu is a very powerful feature — especially so with creative uses of aliases and 
Stationery Pads. Your Apple menu can become very crowded as up to 50 items may be displayed alphabetically. NowMenus™, a 
part of Now Utilities, is helpful in the organization of the Apple menu items. It allows hierarchical viewing and selection of the 
contents of folders in the Apple menu. Put an alias of a folder into the Apple Menu Items folder. With NowMenus installed, you 
can access, from the Apple menu, items stored as deep as 5 levels within the original folder. Some shareware programs, available 
from online services and user groups, also allow hierarchical menus under System 7. I noted with interest that my Apple Menu 
Items folder contains one DA and 16 aliases, most of which are folder aliases. From these selections in the Apple menu, using 
NowMenus™, I can access virtually any of over 1400 files on my hard drive.
Also under the Apple menu is the About This… information box for the foreground application. From the Finder, the Apple menu
no longer has an About the Finder choice. In its place is About This Macintosh. When you select this item you access a dialog 
box with a graphic display of the current allocation of your RAM. It can give you an idea of whether there is sufficient memory 
available to open another program. For a cute surprise, hold down the option key when you select About This Macintosh. Some 
Apple employee must be a frustrated graphic artist.



About This Macintosh… shows current memory allocation.

Find anything, even Waldo
The Finder’s File menu sports a new, beefier look. Among the new selections are Make Alias (discussed earlier) and the Find and 
Find Again commands.

The Finder File menu is beefier.

The Find feature is surprisingly useful, considering how weak the old Find function was. You have the option of using a simple 
find dialog box, which is nice for inexperienced Mac users. If you want power, select the More Choices button to bring up a 
multiple choice Find box. The options are too numerous to detail here. For example, you can find a single file or all files on all or 
selected volumes by various criteria, including name, date created or 



modified, size, version, label, comments, and lock status. Each primary determinant has various secondary criteria as well. 
Although the search function is as powerful as that of many commercial utilities, it does not allow searches by the content (text 
phrases, for example) of files.

The Find command can be simple or powerful.

The Label menu adds new power to the Finder. Choose the Labels Control Panel to configure your labels. You may create 7 
different labels, each with its own color if you have a color monitor, to append to any file. From the Finder, highlight a file and 
select, from the Label menu, the label you wish to add to it. That file will retain the added label until you remove it. This is a 
useful tool for adding an identifying tag to a file for later searching with the Find command. A label is most powerful if you use a 
color monitor. Because the icons of labeled files appear in the color assigned in the Labels Control Panel, they can be quickly 
identified in the Finder.

Define your labels & their colors in the Labels cdev.

The trashman cometh
The trash can looks the same but smells a bit different under System 7. The trash is no longer emptied automatically when you 
start an application or shutdown the Mac. You must select Empty Trash… from the Special menu in the Finder to remove all 
items in the trash.



Toss out your trash manually with System 7.

You have the option of letting the Finder warn you before it deletes all the files in the trash. This may help prevent the inadvertent
deletion of trashed files. You may override this feature by unchecking the Warn Before Emptying box in the Trash’s Get Info box.
One of the few annoying aspects of System 7 is the length of time required to empty the trash. Future versions of the system 
should improve this.

Disable/enable the warning in the Trash’s Get Info box.

Help me, help me, it’s a lark!
With System 7, help is a mouse click away if you wish. Enable and disable balloon help from the Help menu, which appears as a 
question mark inside a balloon near the right end of the Finder menu bar. At this writing, few applications take advantage of Help
balloons. Ideally, by selecting Show Balloons from the Balloon Help menu, you will enable help balloons to appear within an 
application in which you are working. Some users find this feature superfluous and irritating. The PD/Shareware programs 
HelpMeister™ and Helium add options to show help balloons when and how you want them by using keyboard commands, 
something System 7 should have done. As more applications are upgraded to provide their own Help balloons, this feature will be
more useful. Many novices will find Help balloons in the Finder a nice aid. If you feel that the Balloon Help icon crowds your 
Finder menu bar, the NoBalloonMenu extension, available from user groups and online services, will hide it.



Get help from anything on the desktop.

Advanced System 7 features
Interapplication communication (IAC) is a potentially powerful tool of System 7 that will not be fully utilized by software 
developers for many months or years. The most well known of the IAC features is Publish and Subscribe. This is a dynamic ‘Cut 
and Paste’ link between applications. For example, create a graphic in a draw application and select the Create Publisher… 
command from the Edit menu. Name and place the published edition on your hard disk. From within another application, for 
example, a word processor, place the cursor at the desired insertion point for the graphic, and select Subscribe To… from the Edit
menu. Then select the desired published graphic from a Select File menu dialog box. The graphic is now linked to the word 
processor document, and any changes made to it in the graphic application can be automatically updated in the word processor 
document. You have options on when and how the published edition is updated in the subscriber. At the time of this writing, most
commercial programs do not support the Publish and Subscribe feature. Canvas 3.0, RagTime 3.1, Excel 3.0, Lotus 1-2-3, 
MicroPhone II 4.0, and the soon to be released Word 5.0 are some that do take advantage of all or most of System 7’s power 
features, including Publish and Subscribe. QuicKeys 2™ v. 2.1, a popular macro program, also allows IAC via links to Apple® 
Events, which are interapplication messages communicated through the system software.
File Sharing is a powerful new feature of System 7 that is similar to AppleShare and Tops™. Small networks may find these 
expanded file-sharing capabilities sufficient for their purposes. You may share data and applications with other users on the 
network while you continue to control and work on your machine, selecting the levels of access for each user. A dedicated file 
server is no longer necessary. A nice feature is the ability of an individual network user to alter a shared file, thus updating that 
file for all users. A file that has been created as a publisher with the publish and subscribe feature can thus be continuously 
updated, by users with such access privileges, to all subscriber files across the network. The hardware necessary for the basic 
setup is a simple set of LocalTalk connectors. Large offices may require a more sophisticated network.
From the fun department — you can customize any icon, except that of the Trash, from the Get Info box. Create and size your 
icon in a graphics program or borrow one that you like from another source. Many icons are available from user groups and 
online services. Copy your choice to the clipboard. Bring up the Get Info box of the item whose icon you wish to change. Select 
the icon in the Get Info box and paste the new icon on top of it using the Paste command from the Edit menu. To remove an icon,
select it in the Get Info box and delete it with the Edit menu commands. The original icon reappears.

The bottom line
Not all Macintosh users will benefit from switching to System 7, despite its powerful features. As noted earlier, older Macs, such 
as the Plus and SE, cannot use the virtual memory option. If your Mac can use virtual memory, you will need to have the desired 



amount of free space on your hard disk. If your hard disk is only 20 – 60 MB in size, it might be insufficient, depending on what 
you currently have stored there. If your machine has only 2 MB of installed RAM, you will be able to run System 7, but in 
practice, at least 4 MB is needed to take full advantage of multitasking. If you use a lot of INITs and cdevs, the memory required 
by the system can be large. My system memory is usually about 2.6 MB or more.
In addition to the hardware restrictions, there are both user and software limitations to consider. If you have important 
applications that are not System 7 compatible, it would be injudicious to change to the new system. If you are currently in the 
midst of a project, especially if there is a pending deadline, wait until you have finished your project to upgrade. It is always best 
to install a new operating system when you have some time to play or experiment a bit. Many people feel that it is simply 
unnecessary to change systems. That is true for now — however, future versions of most applications will probably work with 
system 6.0.x, but will require System 7 for optimal function and power. Similarly, the old adage ‘If it ain’t broke, don’t fix it’ 
does not really hold true for System 7 as it did for system 6.0. The new system is very stable.
Admittedly, System 7 has a few flaws. It is somewhat slower in Finder activities. Rebuilding the Desktop still deletes the 
comments in all Get Info boxes. It does not copy disk to disk correctly, although it does complete the task. Some crashes may 
occur when using the option switch command to change applications and hide background windows. There are also some 
annoying features of System 7, a few of which were noted earlier. However, these limitations are minor and have little effect on 
routine work.
Apple has released System 7 Tune-Up, an extension that improves stability, especially so for file sharing functions, speeds Finder
actions and improves printing and memory utilization. It is available from online services and user groups. Installation is quick 
and simple. You will notice an improvement as soon as you reboot after installing it. Consider System 7 Tune-Up a necessity — 
and don’t leave home without it.
I heartily recommend the switch to System 7, as long as you have the time, interest and hardware to allow it. The increase in your
productivity will be well worth the time you spend in the process. If you don’t like it, use your back up (you did back up didn’t 
you?) and reinstall your old set-up. All you will have lost will be the small cost of the system disks (very cheap from your user 
group) and the time. At a minimum, you will have learned a lot about your Macintosh. Most likely you will be pleased, and you 
will launch a new, exciting adventure into greatly increased productivity. Who knows — maybe you’ll get a raise. System 7 — 
try it, you’ll like it.
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